Digital X-ray Scanner
EZ240 - EZ320 - EZ400 - EZ480

Part B: Software

iX-Pect EZ
X-ray acquisition and imaging software
for
digital x-ray scanners of the EZ series

State: Oct 20, 2009

1 Introduction 10
1.1 Overview ................................................................. 10

2 Installation 11
2.1 Software Installation.................................................... 11
2.2 Setting the X-ray Generator Frequency.......................... 11
2.3 Starting iX-Pect ......................................................... 12

3 User Interface 13
3.1 The Menu Bar............................................................ 13
3.2 The Toolbar............................................................... 14
3.3 The X-ray Images....................................................... 14
3.4 The Status Bar.......................................................... 15

4 Scanning Images 16
4.1 Views in the Scan Image Dialog................................. 16
4.2 The View "Preview".................................................... 16
4.2.1 Selecting the Image Area......................................... 17
4.3 The View "Line Diagram".......................................... 18
4.3.1 Reference Line.................................................... 18
4.4 The Scanning Parameters......................................... 19
4.4.1 Integration Time.................................................. 19
4.4.2 Pixelbinning....................................................... 19
4.4.3 Double Greylevel / Line Averaging........................ 20
4.5 Scanning Information.............................................. 20
4.5.1 Object Speed in mm/s and m/min.......................... 20
4.5.2 Resolution......................................................... 20
4.5.3 Scanning Time.................................................... 20
4.6 Calibration and Shading Correction........................... 21
4.6.1 Calibrating the Scanner........................................ 21
4.6.2 Select a Calibration File....................................... 23
4.6.3 Shading Correction.............................................. 23
4.7 Working with QuickScan Parametersets.................... 24
4.7.1 Saving QuickScan Parametersets........................ 24
4.7.2 Loading QuickScan Parametersets....................... 24
4.7.3 Starting the Scanning Process from the Toolbar of the Main Window.................................................... 25
4.8 The AutoSave Function............................................. 25
4.8.1 Behavior............................................................ 25
5 Greylevel Variation

5.1 The Histogram............................................................................................................. 27
5.2 Using the Greylevel Variation Function......................................................................... 28
  5.2.1 The Greylevel Variation Dialog................................................................................ 28
  5.2.2 Linear Greylevel Variation....................................................................................... 28
  5.2.3 Spline Greylevel Variation...................................................................................... 30
5.3 Greylevel Variation Step-by-Step.................................................................................. 32
  5.3.1 Step 1: The Image without Greylevel Variation....................................................... 32
  5.3.2 Step 2: The first Survey ......................................................................................... 32
  5.3.3 Step 3: Adjustment of the Linear Greylevel Variation to the Object....................... 33
  5.3.4 Step 4: Switching to the Spline Greylevel Variation............................................... 33
  5.3.5 Step 5: Adjustment of the Spline Greylevel Variation to the Object....................... 34
5.4 Further Functions of the Greylevel Variation................................................................. 35
  5.4.1 Saving and Loading of the Greylevel Variation....................................................... 35
  5.4.2 New Image from Greylevel Variation...................................................................... 35

6 Image Processing

6.1 Cut Edges...................................................................................................................... 36
6.2 Inverting Images.......................................................................................................... 36
6.3 Rotating Images........................................................................................................... 36
6.4 Mirror horizontally and vertically................................................................................ 36
6.5 Edge Enhancement...................................................................................................... 36
6.6 Edge Detection............................................................................................................ 37
6.7 Relief Images............................................................................................................... 37
6.8 Median Filter................................................................................................................ 38
6.9 Pixelbinning................................................................................................................ 38
6.10 Ripple Filter................................................................................................................ 38
6.11 Area Balancing......................................................................................................... 39
6.12 Small Signal Enhancement......................................................................................... 39
6.13 Multiscale Filter........................................................................................................ 40
  6.13.1 Detail Contrast Enhancement.................................................................................. 40
  6.13.2 Smoothing and Sharpening................................................................................... 41
  6.13.3 Latitude Reduction............................................................................................... 41
  6.13.4 Global Options..................................................................................................... 41

7 Measuring of the Image

7.1 Choosing the Unit of Measurement for Coordinates and Distances........................... 42
7.2 Image Coordinates and Pixel Values........................................................................... 42
  7.2.1 Display in the Status Bar....................................................................................... 42
  7.2.2 Display in the Window “Pixel Information”.......................................................... 42
7.3 Measuring of Distances............................................................................................... 42
7.4 Measurement of Greylevel Gradients by the Pixel Profile........................................ 43
7.5 Set Scaling.................................................................................................................. 44
  7.5.1 Using Reference Objects...................................................................................... 44

8 Saving and Loading Images

8.1 Saving Images............................................................................................................. 45
8.2 Loading Images.......................................................................................................... 45
8.3 Exporting images....................................................................................................... 45
8.3.1 BMP - Windows Bitmap..................................................................................................................................45
8.3.2 TIF - Tagged Image File Format......................................................................................................................45
8.3.3 FLD - Binary Field...........................................................................................................................................46
1 Introduction

iX-Pect is a program for the acquisition and processing of x-ray images with NTB's digital x-ray scanners of the EZ series.

1.1 Overview

The program provides varied possibilities of image processing by means of the following functions:

- Scanning of objects with NTB's x-ray scanners of the EZ series
- Direct start of user defined scanning processes by the toolbar
- Image processing and measurement
- Saving and loading of scanned images (format: NTB-PIX)
- AutoSave of scanned images
- Opening, viewing and/or processing of previously saved x-ray images (format: NTB-PIX)
- Exporting x-ray images in TIF (8 bit or 16 bit), BMP (8 bit) and FLD (16 bit raw data)
- Printing x-ray images
2 Installation

If the system was delivered together with a PC, the software is already installed and configured according to the scanner system. In this case there is no need for further configuration of the software and you can skip chapter 2.1.

2.1 Software Installation

1. Please start Windows and login as administrator.
2. Please insert the enclosed installation CD into the CD rom drive of the computer.
3. Then start the program “SetupEZ” in the main folder of the CD. (The exact name may vary, e.g. it is “Setup EZ400” on the CD of the EZ 400.)
4. Click on “Install”.
5. Now you can define in which folder the program should be installed.
   The standard setting is “D:\iX-Pect EZ”.
6. Click on “OK” to start the installation.
7. After successful installation, the program reports “Driver installed successfully. Restart the computer”.
8. Click on “OK” and then on “Quit”.
9. Restart the computer.

2.2 Setting the X-ray Generator Frequency

Some x-ray systems do not provide a constant or a high-frequency x-ray voltage, but a low-frequent x-ray voltage of 50Hz or 60Hz. At low-frequency x-ray systems, the exposure time has to be adapted to the frequency of the x-ray generator.

The integration time at 50Hz systems has to be a multiple of 20ms. So integration times of 20ms, 40ms, 60ms, etc. are allowed.

The integration time at 60Hz systems has to be a multiple of 16.67ms. So integration times of 16.67ms, 33.34ms, 50ms, etc. are allowed.

If this precondition is not be considered, it will come to periodical occurring, vertical stripes in the taken x-ray image.

To simplify the selection of the matching integration times for the user, iX-Pect can be configured that way, that only fixed integration times can be chosen from a dropdown list (see Figure 1).

![Integration Time Selection](image)

**High frequency generator:**
The integration time can be chosen independently

**50 Hz generator:**
Integration times of 20ms, 40ms, 60ms etc. can be chosen from the drop down list. The list is opened in this picture.

**60 Hz generator:**
Integration times of 16.7ms, 33,3ms, 50ms etc. can be chosen from the drop down list.

Figure 1
After installation, iX-Pect is configured in such a way that the integration time can be entered independently. To change the configuration of iX-Pect, you can use the tool “EZConfig.exe” that you will find on the installation CD. Before you change the configuration, make sure that iX-Pect is not running.

2.3 Starting iX-Pect

1. Turn on the computer.
2. Wait until Windows has completed the startup procedure.
3. Press the keys [Ctrl] + [Alt] + [DEL] simultaneously to log in. After that, click on “OK” without entering any password.
4. On the desktop you will see an x-ray icon named "iX-Pect EZ". Doubleclick on this icon to start the program.
3 User Interface

This chapter imparts the basic program elements. Figure 2 shows the main window of the program in which two x-ray images are displayed.

![Figure 2](image.png)

3.1 The Menu Bar

The menu bar contains the drop down menus to call the different functions of the program. To call a function, click on one of the drop down menus in the menu bar. Thereby the menu is opened and you can choose the desired function using either the mouse or the cursor keys. While you choose the function, a short description of the function is displayed on the left side of the status bar.
3.2 The Toolbar

The icons in the toolbar enable fast access to the most important program functions. If you move the mouse over an icon, the function of the icon is displayed on the left side of the status bar. Click on the icon to call the function.

Figure 3 shows the toolbar and the functions of the icons.

![Figure 3: Toolbar and functions of icons]

3.3 The X-ray Images

The x-ray images are displayed in the middle of the main window. The name of an image is displayed in the caption bar.

It is possible to display several windows with different images at the same time. But there is always only one image selected.

Often the x-ray images are too big to display them on the screen in original size. Therefore, you have the possibility to choose between different zoom factors. The zoom factor of the selected image can be changed, by clicking on one of the icons of the toolbar.

If the mouse cursor is on the image, you also have the possibility to change to the next higher zoom level by a double click with the left mouse button, or to switch one zoom level back by a click with the right mouse button.

If a zoom factor is chosen, with which it is not possible to display the complete x-ray image in the window, the displayed image detail can be moved by the scroll bars at the right and at the bottom edge of the image window.

After scanning or loading an image, the zoom factor "Fit to window" (icon) is activated automatically, and the image is displayed completely in its window.
3.4 The Status Bar

The status bar is placed at the bottom edge of the main window. The status bar is divided up into four text fields and a set of buttons (from left to right).

- General information
  General program information are displayed on the left side. For example, if the mouse pointer is placed on an icon in the toolbar, the function of the icon will be displayed here.

- Button “pixel”
  This sets the coordinate system for measurements to pixels.

- Button “mm”
  This sets the coordinate system for measurements to millimeters.

- Button “inch”
  This sets the coordinate system for measurements to inches.

- Coordinates and distances
  Move the mouse on an image. The second field now displays the coordinates of the pixel on which the mouse is placed as well as its greylevel. During the measurement of distances the distance is displayed in this field. You can find more detailed information regarding the measurement of distances in chapter 7.3 on page 42.

- Indicator "Contrast enhancement"
  This field shows the text "Contrast enhancement", if the linear greylevel variation is activated together with the option "Contrast enhancement".

- Indicator "Linear variation"
  This field shows the text "Linear variation", if the linear greylevel variation is activated.

- Indicator "Spline variation"
  This field shows the text "Spline variation", if the spline greylevel variation is activated.
4 Scanning Images

If you choose the function "Scan image" from the menu bar (or click on the icon in the toolbar), the dialog "Scan image" will be opened.

The complete parameters for the x-ray imaging are adjusted in this dialog. Besides you can configure the AutoSave-function with the help of the "File"-menu of this dialog and manage the parametersets for the QuickScan-function.

4.1 Views in the Scan Image Dialog

Two different views are available in the scan image dialog: The view "Preview" and the view "Line diagram". On the upper left side of the dialog you can see the two tabs "Preview" and "Line diagram". With these both tabs you can choose the desired view.

4.2 The View "Preview"

Figure 4 shows the scanning dialog in "Preview" view. This view shows the preview and allows the selection of the image area which should be scanned.

The object which should be x-rayed is in most cases smaller than the complete projection surface of the scanner. As the duration of a scanning process always depends on the image size, it would be a waste of time to scan always the complete projection surface at each scanning process. With the help of the preview you have the possibility to define exactly the area which should be scanned.

![Figure 4](image-url)
If you click on the button “Scan preview” in the lower right corner of the dialog, a preview will be scanned. The scanner drives always with the maximum speed during this scanning process, so that the complete projection surface of the scanner is scanned within the shortest possible time (approximately 7 seconds).

When the view "Preview" is active, the scanned preview is displayed in the middle of the dialog and conveys a preview of the complete image area. The current chosen integration time (see chapter 4.4.1) is used for the scanning of the preview. Thereby you can assess by means of the preview, if the chosen exposure time fits to the x-ray radiation and to the object, or if the image is under- or overexposed.

Note: The preview is saved on the hard disk after the scanning, so that it remains preserved also after a restart of the program.

### 4.2.1 Selecting the Image Area

After you scanned the preview, you can see in the preview, where the object is located on the scanner. Under the preview you can see the both sliders “start” and “end”. With these sliders you can set the image area, which should be scanned in the next scanning process.

In order to move one of the sliders, move the mouse cursor over the slider. Then press and hold the left mouse button and move the mouse to the left and to the right. When you have placed the slider at the desired position, release the mouse button.

In the area "Scan information" you can see the field “Scanning time”. This field shows how long the next scanning process will last. The scanning time does not depend only on the selected image area, but also on the setting of the integration time (see chapter 4.4.1), the pixelbinning (see chapter 4.4.2) and the image quality (see chapter 4.4.3).
4.3 The View "Line Diagram"

Figure 5 shows the scanning dialog in "Line diagram" view. If you choose this view, the scanner will move the detector to the middle of the scanner after a short delay. This view shows the current exposure of the detector line as a diagram:

- The individual pixels of the detector are displayed on the x-axis of the diagram. The first detector pixel is located at the edge of the left side, the last detector pixel is located at the edge of the right side of the diagram.
- The y-axis represents the greylevel of each pixel. The more intensive a pixel is exposed, the higher it is displayed in the diagram.

If the scanning parameters integration time or pixelbinning are changed (see chapter 4.4), you can see the effects of the change immediately in the diagram.

4.3.1 Reference Line

In some cases it is helpful to compare the exposure of the detector at different imaging conditions. By this it is possible to compare, for instance, the object contrast at different x-ray radiation.

If you click on “Save as Reference” in the scanning dialog, the current line which is displayed in the diagram will be stored as reference line. You can fade in and out this reference line with the button “Show reference”. The reference line is displayed blue. The reference line is not saved when leaving the program. So if you leave the program the saved reference line will be lost.
4.4 The Scanning Parameters

The scanning parameters determine the behavior of the scanner during the image scanning process.

### 4.4.1 Integration Time

With the scanner, the image is generated by scanning the object line by line. The integration time determines how long each single line will be exposed.

The integration time can be compared with the exposure time of conventional cameras. A long integration time leads to brighter images. If the scanner is exposed with a high x-ray intensity, a short integration time can be set. But if only a little x-ray intensity is available, the integration time has to be set accordingly high.

The shorter the integration time is, the faster will the object be scanned. If you change the exposure time, you can see in the area "Information", how the scanning time and the scanning speed change. You have to make sure that the maximum scanning speed of 83mm/s will not be exceeded. If this limit is exceeded, the field "scanning speed" will be colored red and you will not be able to start the scanning process.

If you enter an invalid value at the integration time (lower than 2.2ms or higher than 4000ms), the program will correct the input automatically.

**Important for x-ray systems with 50Hz or 60Hz generators:**

Some x-ray systems do not provide a constant or a high-frequency x-ray voltage, but a low-frequent x-ray voltage of 50Hz or 60Hz. At low-frequency x-ray systems, the exposure time has to be adapted to the frequency of the x-ray generator.

To avoid wrong integration times, the input field can be replaced by a drop down list with fixed integration times. See chapter 2.2 on page 11 for details.

### 4.4.2 Pixelbinning

The maximum resolution of the scanner is 12 pixels per mm (pixelsize 83µm). Some applications require high resolution imaging, while other applications require low resolution, but high speed imaging.

The PCI interface provides hardware pixelbinning to increase the scanning speed for high-speed applications. Instead of transferring each single pixel, the PCI interface adds two or more adjoining pixels and transfers the sum of these pixels.

Example 1: integration time = 10ms per line, pixelbinning = 1

- The object is scanned with 12 pixels per mm (pixelsize 83.5 µm).
- The scanning speed is 0.5 meter per minute.

Example 2: integration time = 10ms per line, pixelbinning = 6

- The object is scanned with 2 pixels per mm (pixelsize 0.5 mm).
- The scanning speed is 3 meter per minute.

The bigger the pixelbinning is, the faster will the object be scanned. If you change the pixelbinning, you can see in the area "information", how the scanning time and the scanning speed change. In this process you have to take care that the maximum scanning speed of 50mm/s will not be exceeded. If this scanning speed is exceeded, the field "scanning speed" will be colored red and you will not be able to start the scanning process.
4.4.3 Double Greylevel / Line Averaging

The quantum noise of the x-ray radiation is an important factor for the quality of x-ray images: The x-ray photons hit the detector of the scanner not in a continuous stream, they are statistically spread over time and space. The thereby caused quantum noise superimposes the image information and therefore worsen the signal-to-noise ratio.

If you activate the option "Double Greylevel", the quantum noise will be reduced by half. This is done by rescanning one and the same line multiple times. Then for each pixel the average is calculated from the rescanned lines. In this way you obtain a visibly higher image quality. But the scanning time becomes longer. For the option “Double Greylevel” the number of average lines is fixed to four. Thus the scanning time becomes four times longer.

If the according option in “EZConfig” is switched to a numeric field, the “Double Greylevel” button will be replaced by an input field labeled “Line Binning”. Here the number of averaged scan lines may be entered directly.

4.5 Scanning Information

In the information fields of this area the program displays information regarding the scanning process. The information depends on the settings of the scanning parameters. During the input of the scanning parameters, the information fields which are dependent on these parameters are displayed blue.

4.5.1 Object Speed in mm/s and m/min

To take an image, the scanner moves the detector along the object during the scanning process. A certain speed has to be kept, so that the object can be scanned without distortion. This speed depends on the parameters integration time and on the pixelbinning. Besides the speed will be four times slower, if the option "Double greylevel" is activated.

Both information fields "Object speed (mm/s)" and "Object speed (m/min)" display the speed at which the object will be scanned.

The maximum scanning speed is 83mm/s. If a scanning speed over 83mm/s arises from the settings of pixelbinning and integration time, the scanning speed will be colored red. In this case you will not be able to start the scanning process.

4.5.2 Resolution

This field displays, at which resolution the object is scanned. The resolution is defined by the scanning parameter pixelbinning.

4.5.3 Scanning Time

This field displays the total time of the scanning process. The scanning time depends on the parameters integration time, pixelbinning and the size of the selected image area. Besides the scanning time will be quadrupled, if you activate the option "Double greylevel".

© NTB elektronische Geraete GmbH
4.6 Calibration and Shading Correction

When the scanner gets a homogeneous exposure, all detector pixels should have the same value. But each detector pixel has an individual offset and gain. Therefore, the pixel values of a homogeneous exposed detector will distinguish from each other. This physical effect is called "PRNU = pixel response non uniformity". As a result of the PRNU, an acquired x-ray image will have stripes which run parallel to the scanning direction.

To avoid these stripes, the scanner must be calibrated. During the calibration process, a set of measurements with a different x-ray radiation intensity are carried out. This allows a correction of the PRNU. The result of the measurements is stored in a file, so that it can be recalled later.

The PRNU depends on
1. the spectrum of the x-ray radiation, consequently the x-ray source, the x-ray voltage, the x-ray current and the inspected object
2. the integration time
3. the pixelbinning
4. the geometric setup

So if you change one or more of these parameters, you should select a suitable calibration file. If a calibration for these parameters has not been executed before, you have to create a new calibration file.

If the currently chosen calibration file does not fit to the adjusted imaging parameters integration time and pixelbinning, the button “Calibration” is flashing red. Thereby the program indicates that a new calibration should be made or another calibration file should be chosen.

4.6.1 Calibrating the Scanner

Please carry out the following steps to calibrate the scanner:

1. Remove all objects from the scanner.
2. Open the dialog “Scan image” (select “File => Scan image” from the menu bar).
3. The calibration has to be executed with the same parameters, at which the imaging is to be carried out later on. So set the parameters pixelbinning and integration time to the values, at which you want to x-ray the object (see chapter 4.4).
4. To open the dialog for the scanner calibration (see Figure 6), click on the button “Calibration” to open the calibration dialog:

![Figure 6](image)
As already mentioned before, several measurements with different x-ray intensities are made for the calibration. You can enter the number of measurements in the field right besides the button “Start new calibration”. Three measurements are predefined as standard. In most cases three measurements are sufficient. But if you notice stripes in the x-ray image which run parallel to the scanning direction, you should execute a calibration with 4 or 5 measurements.

After you have fixed the number of measurements for calibration, click on the button “Start new calibration”, to start the calibration process.

Now the program leads you step by step through the single measurements of calibration. For that purpose a new window is opened. The number of the current measurements and a description is displayed on the left side of the window.

By clicking on “Start measurement” the single measurements are started. The x-ray current and the x-ray voltage may not be changed during a measurement.

You can stop the calibration at any time by clicking on the “Cancel” button.

The single measurements for the calibration are executed in the following order:

1. **Offset measurement**
   The first measurement is fundamentally made without x-ray exposure. So switch off the x-ray radiation at first and then start the measurement.

2. **Saturation measurement**
   The second measurement will be made with the maximum used x-ray intensity. For the second measurement it is necessary to switch on the x-ray tube and to adjust the x-ray voltage and the x-ray current to the values, at which the object will be x-rayed later on. After you have set the x-ray current and the x-ray voltage correctly, start the measurement.

   **IMPORTANT**
   Pay attention that the detector or single pixels of the detector are not over-exposed during the second measurement. If the scanner is overexposed, you will be alerted by a flashing warning "Over-exposure! Use less radiation or choose a shorter integration time".
   An over-exposure of the scanner during the second measuring falsifies the calibration. So if you notice an over-exposure, reduce the x-ray intensity or start a new calibration with a shorter integration time.

3. **Measurement 3, 4 and 5**
   The x-ray intensity is reduced steadily for all measurements, which are following the second one. From the third measurement a slider is displayed on the right side of the calibration dialog. This slider shows you if the x-ray intensity for the next measurement is adjusted right. If the slider points at “radiation OK”, the measurement can be started. If the slider points at “too much x-ray-radiation” or “too little x-ray radiation”, the x-ray intensity has either to be reduced or increased.
   The easiest way is to adjust the x-ray intensity with the help of the x-ray current. The x-ray voltage should not be changed if possible. With some x-ray generators it is not possible to change the x-ray current manually. In this case the x-ray intensity has to be adjusted by the x-ray voltage.

4. After all measurements were completed successfully, please specify a file name in which the calibration data should be saved.
   The file name should include the calibration parameters. For instance: Is the calibration for an x-ray radiation of 100kV / 6mA with the settings integration time = 5ms and pixelbinning = 1, a
possible name for the calibration file would be “100kV 6mA 5ms PB1”. With a look at the file name you can see to which image parameters this calibration file fits.

After you entered the file name and confirmed with OK, the calibration dialog appears again. Now the just received calibration file is displayed in the upper area together with the image parameters integration time and pixelbinning. Click on OK to return to the scanning dialog.

### 4.6.2 Select a Calibration File

If you change x-ray parameters or imaging parameters to values for which you have already carried out a calibration, you do not have to make a new calibration. You merely have to choose the corresponding calibration file. For this purpose open the calibration dialog by clicking on “Calibration” in the scanning dialog. In the calibration dialog you can set with the button “Choose file”, which calibration file should be used.

**Example:**

1. At 80kV/10mA you have carried out a calibration with 5ms integration time and pixelbinning 1. You have stored the result under “80kV 10mA 5ms PB1.pnu”.
2. Then you increased the pixelbinning to 6 and made a new calibration. The result was stored under “80kV 10mA 5ms PB6.pnu”.
3. Now you want to make x-ray images with a pixelbinning of 1 again. As soon as you change the parameter pixelbinning from 6 to 1, the button “calibration” flashes red. By this it is indicated that the calibration file does not fit to the imaging parameters. Now click on “Calibration”, to open the calibration dialog.
   In the calibration dialog the field “Pixelbinning” flashes to indicate that the pixelbinning of the calibration file does not fit to the adjusted pixelbinning. Now click on “Choose file” and select the file “80kV 10mA 5ms PB1.pnu”.
4. After that you can close the calibration dialog again. Now the button “Calibration” in the scanning dialog does not flash any longer as the settings for integration time and pixelbinning meet the values in the calibration file.

### 4.6.3 Shading Correction

Another issue when using an x-ray scanner is an inhomogeneity over the total scanner area. The center of the scanner is closer to the x-ray source than the borders. Thus the resulting image is a little brighter in the center than at the borders.

In direction of the line camera this slight shading is corrected as a side effect of the calibration. To get an overall homogeneous image there is the feature *shading correction*. During this process a reference image is taken without any objects in the x-ray beam. That image is used to create a correction function, which results into a homogeneous brightness in scanning direction.

The work flow of the shading correction is very similar to the PRNU calibration.

1. Press the button “New correction” in the group “Shading correction”.
2. Take a reference image with the x-ray intensity that is intended to be used later in the real exposure.
3. Do an offset measurement
4. Save the correction function to a separate file.

The use of the shading correction may be turned on and off by checking the box “Activate”. If the shading correction is deactivated, new images are acquired as if no shading correction was done.
4.7 Working with QuickScan Parametersets

The imaging parameters of the scanning dialog can be stored by the QuickScan parametersets and then can be loaded again later. So you can define different imaging parameters for different objects and then access them later without setting the parameters manually. You also have the option to choose the QuickScan parametersets directly in the toolbar of the main window and to start the scanning process without opening the scanning dialog.

The following information will be stored in the QuickScan parametersets:

1. Selected image area
2. Integration time
3. Pixelbinning
4. Setting of “Double greylevel”
5. Selected PRNU-file

4.7.1 Saving QuickScan Parametersets

In order to save the current settings of the scanning dialog choose “File => Save scan parameter” from the menu of the scanning dialog. Thereby the dialog “Save parameterset” is opened (see Figure 7).

Now you can enter the name of the parameterset in the upper field of the dialog. Already stored parametersets are displayed in a list under “Existing Parametersets”.

If you click on a name in the list of the existing parametersets, you can rename or delete the chosen parameterset with the buttons “Rename” or “Delete”.

Click on “OK” to save the current settings under the name in “Name of Parameterset”. With “Cancel” you can interrupt the saving of the parameters.

4.7.2 Loading QuickScan Parametersets

In order to load the settings of the scanning dialog from a QuickScan parameterset, choose “File => Load scan parameter” from the menu of the scanning dialog. Thereby the dialog “Load parameterset” is opened (see Figure 8).

A list of the stored parametersets is displayed here. If you click on a name from the list, it is marked blue. With the buttons “Rename” or “Delete” you can rename or delete the chosen parameterset. But if you click on “OK” instead, the settings of the parameterset are loaded and submitted in the scanning dialog. With “Cancel” you can stop the loading of a parameterset.
4.7.3 Starting the Scanning Process from the Toolbar of the Main Window

With the help of a drop down field in the toolbar of the main window, you can choose the stored QuickScan parametersets. If you then click on the QuickScan-icon, the scanning process will be started immediately with the parameters of the chosen parametersets.

4.8 The AutoSave Function

After the scanning process, you can manually save the new image with “File ⇒ Save” or “File ⇒ Save as”. But you can also automate the saving of the image with the AutoSave function.

With enabled AutoSave function a file name is automatically generated after each scanning process and the new image is stored under this file name. In the dialog “AutoSave” you can enable and disable the AutoSave-function. You can also define how the file name should be generated.

The configuration dialog for AutoSave can only be reached from within the dialog “Scan image”. Choose “File ⇒ AutoSave” from the menu of the scanning dialog to open the AutoSave dialog.

In order to enable the AutoSave function, set a check in front of “Enable AutoSave”. Afterwards you can define how the file name is generated.

4.8.1 Behavior

Here you can define the general behavior of the AutoSave function after the scanning process:

1. **Save image**
   If this option is activated, the image is saved and remains opened.

2. **Save and close image**
   If this option is activated, the image will be saved and right after that be closed.

3. **Overwrite existing files without prompt**
   If in addition this option is activated, the program will overwrite existing images with the same file name without any security precaution or warning.
4. **Save two files**
   This option allows the user to save the same image in two different formats and / or in two different folders.

4.8.2 **File Type**
   Here you can define in which file format the images should be saved by the AutoSave function. It could be selected between PIX, BMP, TIF (8 bit) and FLD-file.
   - **File type** specifies the file format of the first file.
   - **Secondary file type** specifies the file format of the second file.

4.8.3 **Folder**
   Here you can define in which folder the program should save the images. You can either enter the folder directly in the provided field or choose the folder with the help of the button “Browse”.
   - **Folder 1** specifies the target folder for the first file.
   - **Folder 2** specifies the target folder for the second file.

*Important:* The folder in which the images should be saved must exist.

4.8.4 **File Name**
   In this field you can enter the beginning of the file name. This part of the automatically generated file name remains unchanged and is extended by an index and (optionally) the date and time of the storage.

4.8.5 **Index**
   This field states the index of the next image. This value is added to the file name (see chapter 4.8.4). The index is raised by 1 after each scanning process.
   With the option “Reset index” you can define, whether the index should be reset hourly or daily to a determined value.

4.8.6 **Time and Date**
   With both options “Time” and “Date” you can define, whether the date and / or the time on which the image is saved, should be included in the file name.

4.8.7 **Example**
   The field “Example” displays, how the generated file name will look like.

4.9 **Starting the Scanning**
   In order to start the scanning process, click on the button “Start scan” in the scanning dialog. In order to close the scanning dialog, without starting the scanning process, click on “Cancel”.
   The settings in the scanning dialog will only be saved, if you click on “Start scan”. But if you click on “Cancel” instead, all changes and settings in the scanning dialog will get lost. However, the QuickScan parametersets and the AutoSave settings will remain when you close the dialog by “Cancel”.

© NTB elektronische Geraete GmbH
26
5 Greylevel Variation

The greylevel variation is one of the most important image processing functions of this program. Therefore, please read this chapter attentively!

The dynamic range of the scanner system is 12 bit. That means that the x-ray images are made with 4096 greylevels. Pixels with a low pixel value are displayed dark on the screen and pixels with a high pixel value are displayed bright.

The human eye, however, is only able to distinguish 30 to 50 greylevels, and also the monitor is not able to display 4096 greylevels.

Besides, the x-ray images very rarely use the complete greylevel range. The greylevels of an object may not reach from the pixel value 0 (black) to the pixel value 4095 (white), but, for instance, only from the pixel value 1100 (dark grey) to the pixel value 2600 (light grey).

For these reasons, object details often remain invisible to the viewer of the x-ray image, even though they have been registered by the x-ray scanner. With the help of the greylevel variation you are able to change the display of the x-ray images, so that these object details are clearly visible.

5.1 The Histogram

Before you work with the greylevel variation, you should understand the meaning of the histogram: By means of the histogram it can be seen how many pixels per pixel value are contained in the image. Figure 11 shows the x-ray image of a cylindrical aluminum part and the associated histogram.

The horizontal x-axis in the histogram represents the digitized pixel values from 0 (left) to 4095 (right). It is marked in form of a vertical bar above each pixel value, indicating how many pixels in the x-ray image have this pixel value. The more pixels in an image have a particular pixel value, the higher is the belonging bar.

The x-ray image in Figure 11 can be divided into three major areas: The dark object (1), the brighter area in the middle of the object (2) and the bright background (3).

Now please look at the belonging histogram: On the left side you can see a cluster with two peaks. This cluster belongs to the object: A large part of the image is dark. Therefore many pixels have a low pixel value. Thereby the first peak arises (1). But the object is a little bit brighter in the middle, so that a second peak (2) arises. The transitions between the light and the dark object part are smooth. Thereby the smooth transition arises between peak (1) and peak (2) in the histogram.

Besides you can see a narrow cluster (3) on the right side of the histogram, which arises from the bright background of the image.

The histogram still contains further information: The vertical y-axis represents the brightness from dark (below) to bright (top). By means of the white line in the histogram you can see, at which
brightness the individual pixel values are displayed on the screen. The white line is called “brightness line” in the further description.

In the example of Figure 11, the brightness line runs linear from the lower left to the upper right corner. That means, that pixels with a low pixel value are displayed dark and pixels with a high pixel value are displayed bright.

All pixels of the object lie on the left side of the histogram. There, the brightness line runs from the bottom (black) up to about one third of the total height of the histogram (dark-grey). So the brightness of the object pixels lies between black and dark-grey. The range of the brightness from dark-grey to white contains only the background of the object, which is rather uninteresting. For the user it would be far advantageous, if the object would use the entire brightness range from dark to bright. Such a contrasty representation of the image can be achieved by the greylevel variation.

5.2 Using the Greylevel Variation Function

There are two different types of greylevel variation: The “linear greylevel variation” and the “spline greylevel variation”. This chapter explains the differences between both types and the operation of the greylevel variation function.

### 5.2.1 The Greylevel Variation Dialog

If you choose “Greylevel variation => Define variation” from the menu bar or click on the icon in the toolbar, a dialog will be displayed, with which you are able to set the greylevel variation. In the middle of the dialog you can see a property sheet (otherwise known as tabbed dialog box). This property sheet has two tabs: “Linear greylevel variation” and “Spline greylevel variation”. With these tabs you can switch between both types of greylevel variation. Depending on which type is chosen, different controls are displayed within the property sheet.

Five additional buttons are located below the property sheet:

You can stop the greylevel variation at any time by a click on “Cancel”. In this case the program uses the greylevel variation, which were set before calling the function.

If you choose “OK” you will confirm the present setting of the greylevel variation.

The function of the buttons “Load”, “Save” and “New image” are explained in chapter 5.4 on page 35.

### 5.2.2 Linear Greylevel Variation

At the linear greylevel variation you define a lower and an upper limiting value. All pixel values below the lower limiting value are displayed in black, all pixel values above the upper limiting value are displayed in white. The brightness of the pixel values between both limiting values increases linear from black to white.
Figure 12 shows the dialog, if you have chosen the tab index “Linear greylevel variation”. Directly below the histogram there are the three sliders “dark”, “bright” and “both” at your disposal with which you can change the settings.

To move one of the sliders, move the mouse on the concerning slider, press and hold the left mouse button and move the mouse to the left or to the right side. After you moved the slider to the desired position, release the mouse button.

The slider “dark” defines the lower limiting value of the variation. The slider “bright” is accordingly responsible for the upper limiting value. With the slider “both” you can move the two other sliders simultaneously, without changing their distance.

While moving one of the sliders, you can see the effects immediately at the image.

Below the three sliders you can see numerical fields. In the first row the left and the right field display the lower and the upper limiting value. The field in the middle displays the distance between the both limiting values. In the example in Figure 12, the lower limiting value is 322 and the upper limiting value is 751. That means, all pixels with a pixel value below 322 are displayed black, and all pixels with a pixel value above 751 are displayed white.

The second row displays the percentage of the three ranges. The left field displays the relative portion of pixel values that are darker than the dark limit. In this case no pixel value is below 322. The right field displays the relative portion of pixel values that are brighter than the bright limit. Thus 46.7% of the pixels are cropped to plain white. The field in the middle means, 53.3% of the pixel are within the effective greylevel range.

As you can see from the brightness line in the histogram, the brightness increases linear from dark to bright between the both limiting values. Thereby object areas which pixel values lie between the both limiting values are displayed in high contrast.

While moving the slider “dark” and thereby changing the lower limiting value, parts of the image are inked red. The red parts in the image mark all pixels whose pixel value correspond to the current limiting value. Thereby it is easier to assess, which pixels lie above the limiting value. In the same way, all pixels whose pixel values correspond to the upper limiting value, are inked red while moving the slider "bright".

### 5.2.2.1 Contrast Enhancement

The linear greylevel variation offers a further option: The button “contrast enhancement”. If this button is switched on, the program will try to adapt the course of the brightness line within the current limiting values to the object. The pixel value areas which contain many pixels are displayed in higher contrast, than pixel value areas which contain only few pixels.

*Note: If you want to use the option “Contrast enhancement”, you should first move the slider “bright” so far to the left side, so that the background-peak lies right from the "bright" slider.*
5.2.3  Spline Greylevel Variation

In contrast to the linear greylevel variation, the brightness line of the spline greylevel variation is not linear to the pixel values: By the help of control points, you can set almost any course of the brightness line you wish.

Figure 13 shows the dialog, if you have chosen the tab index “Spline greylevel variation”. Within the histogram, there are six control points with which you can set the brightness line.

To move one of the control points, move the mouse to the concerning control point, press and hold the left mouse button and move the mouse. After you moved the control point to the desired position, release the mouse button.

While moving a control point, the shape of the brightness line in the histogram changes and you can directly see the effects on the image.

As already described in chapter 5.1, the brightness line shows at which brightness the individual pixel values are displayed. The steeper the curve ascends in a pixel value area, the more contrasty is the representation of the pixels that lay in this area.

Please have a look at the example in Figure 13: By means of the high cluster on the left side of the histogram you can see that a large number of the object pixels have a low pixel value. So this pixel value area is very interesting. The control points in the histogram are set in a way that the brightness line on the left side, where most of the pixels are located, ascends steeply and then flattens to the right. The interesting object part is thereby displayed in high contrast.

5.2.3.1  Cubic and Linear Interpolation

Figure 14 shows the difference between both kinds of interpolation: The positions of the control points are the same in both histograms, only the kind of interpolation is different. At the cubic interpolation the brightness line runs always smooth, that means, there are no peaks. At the linear interpolation the individual control points are connected by straight lines, so that peaks arise at the control points.

The cubic interpolation is especially suitable for the setting of smooth brightness lines. For sharp-edged brightness lines the linear interpolation is more suitable.
5.2.3.2 Apply Linear Variation

As already described in the introduction of this chapter, the interesting part of the object is often limited to a small pixel value area. In the spline greylevel variation it is possible to zoom into the histogram by activating the button “apply linear variation” (see Figure 15). If “apply linear variation” is activated, only the part of the histogram will be displayed at the spline greylevel variation which is situated between the sliders “dark” and “bright” of the linear greylevel variation. This allows a more precise setting of the brightness curve.
5.3 Greylevel Variation Step-by-Step

In this chapter the setting of the greylevel variation is explained step by step by the example of a real x-ray image.

### 5.3.1 Step 1: The Image without Greylevel Variation

Figure 16 shows the x-ray image and the histogram of an archeological find directly after the imaging. Without the greylevel variation only a black object in front of a white background is visible.

![Figure 16](image)

### 5.3.2 Step 2: The first Survey

First of all you should use the linear variation to find out in which grey-level area the interesting object details are located.

For that purpose, the sliders “dark” and “bright” in Figure 17 are set to a very small pixel value area. Now the details inside the object become clearly visible. But therefore, however, the edge areas of the object can no longer be seen.

![Figure 17](image)
5.3.3 Step 3: Adjustment of the Linear Greylevel Variation to the Object

The details inside the object are clearly visible in Figure 17. But it would be desirable, if the edge area and the contour of the object remained recognizable at the same time.

In order to achieve this, the sliders “dark” and “bright” are moved so far apart that all pixel values of the object lie between the sliders.

![Figure 18](image)

For the exact setting of the slider the program offers a useful support: At first, move the sliders “bright” totally to the right side and then slowly to the left side again. As described in chapter 5.2.2, parts of the image are inked red during the process. As long as the slider is located on the right side, only parts of the background are inked red. When the slider approaches the middle of the histogram, the background will become white again and instead the edge areas of the object are inked red. If the slider moves on to the left, the red areas will go in the direction to the middle of the object. The slider “bright” should be set that way, that the outer edge pixels of the object are inked red.

The slider “dark” is set in a similar way: It is moved slowly from left to right, till the first pixels in the middle of the object are turning red.

5.3.4 Step 4: Switching to the Spline Greylevel Variation

After the setting of the linear grey-level variation according to step 3 it will be switched to the spline greylevel variation.

There, the option “apply linear variation” is activated, in order to zoom into the histogram.

![Figure 19](image)
5.3.5 Step 5: Adjustment of the Spline Greylevel Variation to the Object

Under step 1 it was noticed that the details inside the object are lying mostly in the lower greylevel area. So it is useful to display pixels in the lower greylevel area as contrasty as possible. The rather uninteresting edge of the object in the upper greylevel area should still be visible but may be displayed with less contrast.

The desired representation is achieved by the spline greylevel variation as shown in Figure 20: The brightness line ascends steeply in the lower greylevel area, so that the details in the middle of the object are represented contrasty. The brightness line flattens more and more in the upper greylevel area, so that the edge of the object remains visible but it is represented with less contrast.
5.4 Further Functions of the Greylevel Variation

5.4.1 Saving and Loading of the Greylevel Variation

With the button “Save” you can store the current greylevel variation. After a click on “Save”, you can enter the file name in a dialog, under which the greylevel variation should be saved.

With the button “Load” you can load a previously saved greylevel variation from a file.

If you x-ray the same objects with the same settings again and again, it is circumstantial to set the greylevel variation for each image individually. Therefore, it is useful to set the greylevel variation for one single image optimally and to save it. Afterwards you can use the saved greylevel variation for all other images again.

5.4.2 New Image from Greylevel Variation

If you change the greylevel variation, only the representation way of the image will be changed. The image data itself remains unchanged. In this way it is guaranteed, that the original image (and with it the contained information) is always kept during the greylevel variation.

In some cases it is desirable, however, to change not only the way of representation, but also the image data. For instance, if the object only has a small contrast, it is difficult to set the linear variation correctly.

For this purpose, you find in the greylevel variation dialog the button “New image”. If you click on this button, the program will create a new image by use of the current greylevel variation.

The image is created in a new window, so that the original image will not get lost.
6 Image Processing

6.1 Cut Edges

The scanned images can be very large. If there is only a small area of the image which is interesting, you can use this function to cut off the edges of the image. For this purpose choose the function “Edit => Cut edges” from the menu bar or click on the icon in the toolbar. After that it is necessary to select the concerning area. For this reason click with the left mouse button on the first corner of this part of the image. It is unimportant if you first choose one of the lower, upper, left or right corners. Then release the mouse button and move the mouse. During mouse movement, you will see a rectangle from the first corner to the current mouse position. If the image is bigger than the screen window, the image detail will be scrolled automatically, as soon as you reach the edge of the screen window.

If you click a second time to fix the rectangle, the following warning note will be displayed: “Cut edges can not be undone. Do you want to proceed?” If you click on “Yes” the edges that lie outside this rectangle will be cut off.

You may cancel this function at any time by hitting ESC.

Warning: After you have cut off the edges it is not possible to get back the complete image again.

6.2 Inverting Images

The x-ray scanner creates so-called positive images, in contrast to the conventional film-based x-ray systems. That means, highly irradiated parts of the image are bright, less highly irradiated parts of the image are dark. Conventional x-ray systems behave conversely: Highly irradiated parts of the image are represented dark and less highly irradiated parts of the image are represented bright.

If you prefer the conventional representation, you can reverse the greylevels with the help of the “Invert-Function”. Then dark image parts are represented bright and vice versa.

6.3 Rotating Images

The rotate functions offer the possibility to rotate the image by 90° to the left or to the right.

6.4 Mirror horizontally and vertically

The mirror functions offer the possibility to reflect the image horizontally (from left to right) or vertically (from top to bottom).

6.5 Edge Enhancement

The sharpness of the images is enhanced by means of this function without intensifying the noise too much.

The edge-enhanced image is generated in a new window. In this way the original x-ray image will not get lost.
6.6 Edge Detection

The edges of the image are set off especially contrasty by this function.

![Original X-ray Image (Integrated Circuit)](image1.png)  ![Image with Edge Detection](image2.png)

**Figure 21**

After you have chosen the relief-function, you can change the settings of the relief-function in a dialog. With the parameter “noise reduction” you can set, if and how intensive the noise should be reduced before the actual function. With the option “Greylevel variation” you can choose, if the function should use the unchanged original image, or if it should work with the currently selected greylevel variation.

The edge-detection image is generated in a new window. In this way the original x-ray image will not get lost.

6.7 Relief Images

This function generates a relief of the x-ray image (see Figure 22). Image parts with homogeneous brightness appear in the relief as a smooth surface. Transitions from bright to dark are presented as heightenings and transitions form dark to light as deepenings. Thereby arises a three-dimensional impression of the image.

![Original X-ray Image (Integrated Circuit)](image3.png)  ![Relief of Original X-ray Image](image4.png)

**Figure 22**

After you have chosen the relief-function, you can change the settings of this function in a dialog. The parameter “Direction of light” defines from which direction the relief is illuminated. The relief image in Figure 22 is illuminated from the upper left corner. The parameter “Depth” determines the distance between the high-seated and deep-seated parts of the relief.
The relief image is generated in a new window. In this way the original x-ray image will not get lost. The relief effect obtains the best results at images with medium or high contrast.

6.8 Median Filter

Every x-ray image is superimposed by the so-called quantum noise as already explained in chapter 4.4.3 on page 20. The quantum noise has a negative effect on the image quality.

The quantum noise of an x-ray image can be reduced by means of the median-filter, without blurring the image too much. So the image remains sharp despite the application of the median-filter. Very small image details, however, get lost by the median-filter.

The median-filter is available in two strengths. After you have called the median-function, you can choose the filter strength in a dialog: The “5x5”-filter removes more quantum noise than the “3x3”-filter. But through the “5x5”-filter, more image details will get lost than through the “3x3”-filter.

6.9 Pixelbinning

By means of this function several pixels of the x-ray image are combined to one pixel by averaging. Thereby the quantum noise in the image (see chapter 6.8) is reduced. So the signal to noise ratio of the x-ray image is improved by the pixelbinning. But as a result, however, the resolution of the image is reduced.

After calling the pixelbinning-function, you have to specify how many pixels should be binned in the x-direction (horizontally) and in the y-direction (vertically). The binned image will be generated in a new window. So the original x-ray image will not get lost.

Note: To keep the geometrical proportions of the x-ray image undistorted, it is important that equal numbers of pixels are binned in both directions.

6.10 Ripple Filter

It may happen that newly acquired images contain ripples or stripes of fluctuating exposure. This can have different reasons – fluctuations of the x-ray power, a bad calibration, etc. The ripple filter serves the purpose to neutralize those ripples which results in a better image quality.

This image correction is done by comparing its overall brightness of line section to their near surroundings. Therefore the filter has a direction and two adjustable parameters.

Ripple direction: means the direction of the ripples or stripes themselves. E.g. if the scanning direction is from top to bottom, a bad calibration may cause vertical stripes. A vertical ripple direction would be selected to reduce those stripes.
**Width of line average**: is the width of the line sections which are used to calculate the average brightness. Unfortunately, the filter is prone to strong parallel lines which may cause artifacts. Raising the line width makes the artifacts weaker but wider. Lower the line width makes the artifacts smaller but stronger.

**Number of compared lines**: means the height of the environment, the line sections are compared to. This value should be similar to the distance between two ripples.

### 6.11 Area Balancing

The area balancing reduces the dynamic range of the image by means of a circular median filter and image subtraction. The resulting image still has the small details but requires only a very small grey-level range.

![Original x-ray image](image1.png)  ![Area balanced image](image2.png)

**Figure 24: Archeological locket**

**Minimum area diameter**: is the diameter of the circular median filter. The greater the diameter, the more the small image details are emphasized.

**Strength**: represents the percentage of the median image in comparison to the original image. By raising the strength the dynamic range of the resulting image becomes smaller.

### 6.12 Small Signal Enhancement

The small signal enhancement emphasizes small details with low contrast. The contrast of these details will be increased. Furthermore, on edges with high contrast, the filter works like an edge enhancement filter.

For the small signal enhancement, the image is filtered by means of unsharp masking and image subtraction, which is a totally different approach compared to the multiscale filter (see below). Due to his behavior on edges, the small signal enhancement filter can cause disruptive artifacts in the image.

**Mask size**: This parameter relates to the size of the unsharp mask. The greater the mask size, the broader the transitions between different brightness levels.

**Strength**: The strength of the filter represents the percentage of the unsharpened image in comparison to the original image. Lowering the strength increases the fraction of the original image, raising the strength increases the fraction of the unsharpened image.
6.13 Multiscale Filter

The main purpose of the filter is a contrast enhancement of small image details. While the aim of the filter is similar to the Small Signal Enhancement (see above), the implementation is far more flexible, and it is less prone to artifacts.

Smoothing, sharpening and latitude reduction are secondary functions of the filter.

![Multiscale filter](image)

Figure 25: Screenshot – Multiscale filter

6.13.1 Detail Contrast Enhancement

The details of the image are emphasized in a non-linear manner in relation to their surrounding area. A small detail, which already has a high contrast to its surroundings, might not be emphasized very much. At the same time another detail with very small contrast might be amplified much stronger.

![Byzantine coins](image)

Figure 26: Byzantine coins

**Strength:** The slider can be used to define the strength of the filter. The number field on the right hand of the slider shows the strength in %, where 0% means that this part of the filter will not be used. To turn off this part of the filter, either the slider can be moved to the left, or the “off” button can be clicked.
Options: "Automatic histogram normalization" and "Manual histogram normalization" determine the way how the resulting pixel value are normalized after the filter. Currently it is recommended to leave the option at "Manual histogram normalization = 150".

6.13.2 Smoothing and Sharpening

Strength and behavior: The slider can be used to define if the filter shall perform a smoothing or an additional sharpening of the image. Again, the field next to the slider shows the exact value in %. A negative value means smoothing, a positive value means sharpening, 0 means neither smoothing nor sharpening.

Depth: The depth defines the size of the details that are involved. If it is set to 1, only the smallest details will be smoothed or sharpened. If it is set to 8, all detail sizes are involved. Normally, the depth should be 2 or 3.

6.13.3 Latitude Reduction

Strength: The latitude reduction reduces the overall dynamic range of the image. If the latitude reduction is used, the contrast difference between large areas gets reduced. The slider defines the strength of the latitude reduction.

Depth: The depth of the latitude reduction defines the size of the areas for which the contrast is reduced. If it is set to 1, only the largest areas are involved. If it is set to 8, also the contrast between smaller areas is reduced.

6.13.4 Global Options

Scale histogram of result image: If the option is used, the histogram will be spread after the filter to use more of the dynamic range. This is done by changing the pixel values, not by window leveling. Thus the option should be used with care.
7 Measuring of the Image

The program provides different functions to make measurements in the image.

7.1 Choosing the Unit of Measurement for Coordinates and Distances

For the display of coordinates and distances, three different units of measurement are available: Pixel, millimeter and inch. You can choose in the menu “Measurements” which unit of measurement should be used, or you can choose the unit directly with the according buttons in the status bar.

7.2 Image Coordinates and Pixel Values

7.2.1 Display in the Status Bar

While moving the mouse inside the image, the current coordinate of the image pixel, above which the mouse pointer is located, and its pixel value are displayed in the status bar.

![Figure 27](image)

Note: If the greylevel variation is turned on, not the real pixel value will be displayed, but the pixel value which results from the greylevel variation.

7.2.2 Display in the Window “Pixel Information”

With the function “View => Pixel information” you can fade in or out the window “Pixel information”.

This window shows a matrix with the pixel values which are surrounding the mouse pointer (Figure 28). The value of the pixel, above which the mouse pointer is located, is shown in blue in the middle of the matrix. The pixel values of the adjacent pixels are displayed in red, and the values of the next but one surroundings are displayed in green.

The lowest line of the window indicates at which image coordinate the mouse pointer is located.

Note: If the greylevel variation is on, not the real pixel values will be displayed, but the pixel values which result from the greylevel variation.

7.3 Measuring of Distances

In order to measure distances, move the mouse pointer to the initial point from which you want to start the measurement. Then press and hold the left mouse button. This point now serves as reference point and the mouse pointer changes into a crosshair. If you now move the mouse with furthermore pressed mouse button, a measuring line will be drawn from the reference point to the current position of the crosshair.

The length of this measuring line is displayed in the status bar (see Figure 29).

![Figure 29](image)
As soon as you release the left mouse button, the measuring line disappears and instead of the distance, the coordinates are displayed in the status bar again.

7.4 Measurement of Greylevel Gradients by the Pixel Profile

The greylevel gradient along a line can be measured with the help of a pixel profile. The pixel profile is accessed using the distance measurement:

At first move the mouse pointer on the pixel at which the pixel profile should start. Then press and hold the left mouse button and move the mouse pointer to the point, at which the pixel profile should end. During this process, a measuring line will be displayed in the image (see chapter 7.3).

Hold the left mouse button pressed and click the right mouse button in addition. Thereby a new window is opened, in which the gradient of the pixel values along the line is displayed as a diagram (see Figure 30). Now you can release both mouse buttons.

![Figure 30](image.png)

The x-axis of the diagram represents the position on the measuring line. The unit for the x-axis is “Pixel”. The pixel at which you have started the distance measurement is located on the left side of the diagram. The y-axis displays the associated pixel values. If the greylevel variation is on, not the real pixel values will be displayed, but the pixel values which result from the greylevel variation.

If you move the mouse pointer inside of the diagram, the nearest pixel will be marked with a red crosshair in the diagram. The value of this pixel as well as its distance from the start point of the measure line is displayed below the diagram. Besides the position of the pixel is marked on the measure line within the image.

The way of representation of the diagram can be changed with the help of two buttons down left in the pixel profile window. If the button is activated, the pixel profile will be represented as a connected line. If the button is activated, every pixel will be represented as a vertical bar.
Furthermore some statistical information are shown in the dialog. They only include the pixel values along the measured line and in contrast to the graph the statistical values do not regard the greylevel variation.

- **Min**: the minimum pixel value in the measured line
- **Avg**: the average pixel value in the measured line
- **Max**: the maximum pixel value in the measured line
- **Sigma**: the standard deviation in the measured line

Please click on OK to close the pixel profile window.

### 7.5 Set Scaling

The resolution in the x-ray images is calculated without x-ray magnification, because objects are usually placed directly on top of the scanner and the resulting x-ray magnification is quite low. If the precision of the resolution is not sufficient for certain measurements, the resolution of the image can be modified manually.

From the main menu select “Measurements => Set scaling”. A dialog appears, that allows to change the resolution of both axes with a constant ratio or to change the resolution of the axes separately.

![Figure 31: Scaling dialog](image)

The size of a pixel can be entered directly. If the button “Use last measured distance” is clicked, the data from the last measurement as described in section 7.3 is entered in the fields. As soon as dialog is confirmed, the resolution in the x-ray image is updated.

#### 7.5.1 Using Reference Objects

The best way to get a precise resolution is the use of a reference object in the x-ray beam.

1. Prepare the exposure and put a reference object of well known size (e.g. a metal ruler) in the scanning area.
2. Carry out the exposure.
3. Measure the length of the object as described above.
4. Open the scaling dialog.
5. Click “Use last measured distance”.
6. Enter the real length of the object either in the mm field or the inch field.
7. Confirm the change with “OK”.

Now, new measurements will provide correct data in respect to the x-ray magnification.
8 Saving and Loading Images

8.1 Saving Images

In order to save an x-ray image, choose “File => Save” from the menu bar or click on the icon in the toolbar. In the following dialog you can define the file name and the place, under which the image should be stored.

The program uses the proprietary format “PIX”, to save the x-ray images. This file format stores not only the image data, but also additional information (for instance, the settings for the greylevel variation).

After you have saved an x-ray image, the file name appears in the title bar of the window in which the x-ray image is displayed. If you change the x-ray image (e. g. if you set an other greylevel variation), you can save the changes with “file => Save”, without entering the name again. If you want to save the image under another name, choose “File => Save as”.

8.2 Loading Images

In order to load a previously saved x-ray image, choose “File => Load” from the menu bar or click on the icon in the toolbar. In the following dialog, you can choose which image you want to load. You can also load more than one image by marking several images in the file dialog (for example, by pressing the CTRL key while clicking on a file name).

8.3 Exporting images

If you want to use an x-ray image in other image processing programs or in documentation you have to export the image before. For this purpose choose “File => Save as” from the menu bar. In the following dialog you can choose in the field “File type” the file format under which the image should be saved.

Important: The program only reads images of the file type “PIX”. So if you choose another file type as “PIX”, you will not be able to load the image by iX-Pect.

If you export an image into another file format, in principle the defined greylevel variation will be considered. So, you exactly export the image, which you can see on the screen.

The following file formats are available for the export:

8.3.1 BMP - Windows Bitmap

BMP is the standard image format “Windows Bitmap”, which is used by many other programs.

The BMP-format can only save greylevels up to a depth of 8 bit. That means, a BMP-image can not save the complete dynamic range of the scanner with 12 bit. Therefore, before you export an image as BMP-file, you should set the greylevel variation that way, that all important image details can be seen.

8.3.2 TIF - Tagged Image File Format

As soon as you chose “TIF” as file type, you can choose from an option field, whether you want to save the image with 8 or 16 bit.

- 8 Bit TIF:
  Like the BMP-format the 8 bit TIF-format is a standard format, which is supported by many other programs. But also in this format greylevel information is lost (see chapter 8.3.1). Therefore, before you export an image as 8 bit TIF-file, you should set the greylevel variation that way that all important image details can be seen.
• 16 Bit TIF:
The 16 bit TIF-format is a special form of the TIF-format. In contrast to the formats BMP and 8 bit TIF, this format is able to save the x-ray image without any loss. The 16 bit TIF-format is supported by fewer programs than the 8 bit TIF-format.

8.3.3 FLD - Binary Field

The FLD-format saves the image data as a raw binary file without header.

If you export the x-ray image as FLD-file, the program will create two files. The first file with the extension “.FLD” contains a description of the image in ASCII-code. The second file with the extension “.BIN” contains the real image data. If you, for instance, enter the file name “image1”, the files “image1.fld” and “image1.bin” will be created.

The format of the image describing FLD-file should be illustrated by the following example: The image is 1632 Pixels wide and 696 Pixels high. “My image” was set as file name. Then the created FLD-file looks as follows:

<table>
<thead>
<tr>
<th>Entry in the FLD-file</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td># AVS field file</td>
<td>Header identification code (fixed)</td>
</tr>
<tr>
<td>ndim = 2</td>
<td>The image is two dimensional (fixed)</td>
</tr>
<tr>
<td>dim1 = 1632</td>
<td>Image width = 1632 pixels</td>
</tr>
<tr>
<td>dim2 = 696</td>
<td>Image height = 696 pixels</td>
</tr>
<tr>
<td>nspace = 1</td>
<td>(fixed)</td>
</tr>
<tr>
<td>veclen = 1</td>
<td>(fixed)</td>
</tr>
<tr>
<td>data = short</td>
<td>Type of pixel data: short (1 Pixel = 16 Bit, fixed)</td>
</tr>
<tr>
<td>field = uniform</td>
<td>(fixed)</td>
</tr>
<tr>
<td>variable 1 file=My image.bin filetype=binary skip=0 endian=ibm</td>
<td>1. belonging file with the image data  2. file type is binary (fixed)  3. (fixed)  4. little endian (low-byte / hi-byte, fixed)</td>
</tr>
</tbody>
</table>

The pixel data in the file “My image.bin” are built up as follows:

<table>
<thead>
<tr>
<th>Offset (hex)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000 0000</td>
<td>Low-Byte Pixel (x=0,y=0)</td>
</tr>
<tr>
<td>0000 0001</td>
<td>Hi-Byte Pixel (0,0)</td>
</tr>
<tr>
<td>0000 0002</td>
<td>Low-Byte Pixel (1,0)</td>
</tr>
<tr>
<td>0000 0003</td>
<td>Hi-Byte Pixel (1,0)</td>
</tr>
<tr>
<td>....</td>
<td>....</td>
</tr>
<tr>
<td>0000 0CBE</td>
<td>Low-Byte Pixel (1631, 0)</td>
</tr>
<tr>
<td>0000 0CBF</td>
<td>Hi-Byte Pixel (1631,0)</td>
</tr>
<tr>
<td>0000 0CC0</td>
<td>Low-Byte Pixel (0,1)</td>
</tr>
<tr>
<td>0000 0CC1</td>
<td>Hi-Byte Pixel (1,1)</td>
</tr>
<tr>
<td>....</td>
<td>....</td>
</tr>
<tr>
<td>0022 AA00</td>
<td>Low-Byte Pixel (1631, 695)</td>
</tr>
<tr>
<td>0022 AA01</td>
<td>Hi-Byte Pixel (1631, 695)</td>
</tr>
</tbody>
</table>